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Using Online Design 
The process for creating that one book that tells the story of your school’s year and 
captures all the precious memories is constantly evolving. 

Today, many yearbook staffs build their book entirely online using the power and 
convenience of the Internet. Walsworth’s Online Design 2016 harnesses that power and 
provides the advanced tools and capabilities you need to build the yearbook you want.

This manual will give you an overview of Online Design 2016, cover all the basics and get 
you well on your way to creating your masterpiece. But it’s just the beginning. Throughout 
the year, continue to reference the Online Design section at yearbookhelp.com for answers 
to your questions.

INTRODUCTION
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GETTING STARTED
To begin working on your yearbook with Online Design 2016, you need to get organized. 
This section outlines the following:

• The list of system requirements your computers must be ready to handle in order 
to run Online Design 2016

• How to log in, create staff user accounts and set permission levels
• New functionality on the Home page, which provides an even simpler snapshot 

view of your entire book’s progress in one spot
• Online Design 2016’s internal messaging system, which will allow your staff to 

stay in constant communication

System Requirements

Meet with your school’s network administrator at the beginning of the year and review what 
your computers will need to run Online Design 2016. Share this list of system requirements.

Required Internet bandwidth
One megabit per second, or better, inbound and outbound, available to any workstation 
connecting to Online Design 2016.
 
Adobe Flashplayer: Version 13 or latest version
 
Web caching: Walsworth URLs should be exempted from the school district’s web-
caching policy.
 
Required fi rewall ports: Online Design 2016 requires a persistent connection for a two-
way exchange of data. Port 80 and port 443 must be open in both directions in the fi rewall 
or proxy.
 
Supported browsers 
(Recommended in order of best performance)
Google Chrome 33 or newer, Safari 5.0 or newer, Internet Explorer 10 and 11, and Mozilla 
Firefox.
*FrontMotion Firefox is not supported.

 
Required URLs for Firewall and Content Filter
 *.walsworthyearbooks.com (recommended)
www.yearbookhelp.com
walsworth.webex.com
walsworth.com
 
*.walsworthyearbooks.com may be used to replace all walsworthyearbooks.com individual URLs in 
the content fi lter. Please contact Walsworth Computer Support if your web content fi lter or fi rewall 
must use IP addresses.
 

SECTION �1
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Security note:  If implementing an Intrusion Prevention System (IPS), please add Walsworth 
URLs to the exception list.  Online Design 2016 does pass data in the form of XML,which 
can be misinterpreted by some IPS as malware.

Adobe Acrobat/Reader PDF
At minimum, Adobe Acrobat or Reader 9+ should be installed and activated for your 
browser. Reader 9.5 or XI is recommended. 
*Line Weights display improperly with Reader X. Please do not use.

Java Runtime Environment
The Oracle Java SE7 or newer is required on all client workstations that will use 
Walsworth’s Speed Test, Check my Computer, or W|eCare connections*. Apple systems 
require at least Java 1.4 for Mac.

*.webex.com needs to be added to the Security, Exception Site List

Proxy Servers and Proxy PAC fi les
Members Only and Online Design 2016 have not been written to be proxy auto-confi g 
(PAC) fi le aware.  Also, it is recommended that Walsworth URLs be exempted from Proxies.

Wireless networks and Online Design 2016
It is highly recommended that Online Design 2016 users connect over a standard network 
cable at 100 mbps or better. While the program can be accessed and run over a wireless 
connection, any interference with the wireless signal can result in lost connections and very 
slow performance. Whenever possible, use a cabled connection over a switch.

Recommended basic browser settings
Empty Temporary Internet Files folder when browser is closed.
Modify or disable “Pop-up Blocker” for Walsworth URLs.
Use SSL 3.0.     
Use TLS 1.0.
Enable Java.
Enable Java scripting.
Run Active X controls and plug-ins.

SECTION �1
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Logging in to Online Design 2016

Getting logged in to Online Design 2016 should be the easy part. 

All Online Design advisers will receive a Welcome email with their username and password, 
which they can use to log in to Online Design 2016 for the fi rst time. To log in:

1. Go to walsworthyearbooks.com.
2. In the upper right corner, click Login.
3. Type in your username and password. Click Login. You will now be directed to your 

Members Only page.

The link to access Online Design 2016 can be found near the top left portion of the 
Members Only home page, labeled “Online Design Create my yearbook.”

Creating User Accounts and Setting Permissions

Before the yearbook staff can get started working on pages in Online Design 2016, the 
adviser must set up user accounts. This is done through the Members Only area.

Use the following steps to create staff accounts.

1. Once logged in to Members Only, click the Staff and Permissions link near the top 
left corner.

SECTION �1
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2. On the Staff and Permissions page, click the Create new user link at the bottom of 
the page.

3. Fill in the new user’s Name, a User ID and Password for them, then click the radio 
button to set the proper permission level. There are three default permission levels 
for Online Design 2016 accounts:

• Administrator – High level of access that can do anything within Online Design 
2016; typically for a co-adviser 

• Editor – This level can edit any spread and use most management features 
in Online Design 2016, but they can’t change the status of the Adviser or an 
Administrator

• Staff – Level typically given to most staff members; they have access to work on 
their assigned spreads

4. You can choose a custom set of permissions for a user by clicking Set custom 
permissions.

SECTION �1
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5. Click the Members Only or Online Design tab at the top to select the area you would 
like to set custom permissions for. Then simply click the checkboxes and radio but-
tons for the areas you would like that user to have permission to access. When you 
are fi nished, click Save.

6. You can also add a profi le photo for the user that will display within Online Design. 
Click Add photo in the upper left corner. 

7. Navigate to where the user’s mug shot photo is located on your computer and select 
it. Click Open. The photo should now appear in the top left corner.

8. Once all the account information has been fi lled in, click Create user in the lower 
right corner.

Once a user has been created, a badge for the account should be visible on the Staff and 
Permissions page under My yearbook staff. These users will also now appear within Online 
Design 2016.

At the time you create a new user, you will create a user ID and an initial password. The 
user will be required to change the password when logging in for the fi rst time. If you need 
to reset the password or delete a user, head back to Staff and Permissions to perform 
those tasks.

Online Design 2016’s home page

After logging in, each Online Design 2016 session starts on the home page, which 
functions like a dashboard and provides quick access to the most important information 
about your yearbook.

Take a look around the home page:

• Primary navigation – The main navigation menu in the top left corner is 
persistent throughout Online Design 2016 and takes you to the fi ve areas of the 
site: Online Design (home page), Photos, Artwork, Plan Book, and Portraits and 
Index. Each of these areas are outlined later in this manual.

SECTION �1
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• Ladder – A snapshot view of your ladder is front and center on the home page, 
showing you the current status of every spread. New to Online Design 2016 is 
a drop-down menu of staffers at the top of the ladder for advisers, so they can 
zero in and see what work is being done.

• Calendar – Located in the top right corner, the calendar always displays the 
current and upcoming month. Plus, any upcoming due dates will be indicated on 
the calendar in bold.

• Book Progress/Live Yearbook – Also in the top right corner, the Book Progress 
pie chart provides a constant graphic reminder of your book’s progress. Clicking 
Live will open a Live Yearbook window, and show the current status of your 
spreads in a page fl ipper preview. 

• To-Do’s – You can leave notes reminding staffers about certain assignments or 
tasks that need to get done in the To-Do’s area.

• Footer navigation – Within Online Design 2016’s persistent navigation along the 
bottom of the page, there are links to open messaging, upload photos, recently 
edited spreads and notifi cations sent by Walsworth Yearbooks.

• Logout – Click here when you are done working to exit Online Design 2016.

Using the Message Center

As you work throughout the year, your yearbook staff needs ways to communicate. Online 
Design 2016 provides a couple of different ways for users to communicate in real time right 
within the program.

Staff members can send instant messages about a deadline, a question about a spread or 
a story, or any other topic using the Message Center.

Messaging in Online Design 2016 resembles chat sessions used on most social media sites 
or smartphones so it’s easy to follow. 

To send a new message:
1. Click Messages in the lower right corner of the screen in the footer navigation.      
2. In the window that pops open, click +New.

SECTION �1
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3. In the new message window, all users will be displayed under the To: menu. Scroll 
through and click to select who will be receiving the message. You can click more 
than one person to receive a message.

4. Type your message in the text fi eld.
5. Click Send.

To read existing messages:
1. Click Messages in the lower right corner of the screen in the footer navigation.
2. In the window that pops open, your list of past conversations will be displayed in the 

left column. Click to highlight the conversation you want to read.
3. The highlighted conversation will be displayed in the column on the right. You can 

continue the conversation by typing a message in the text box and clicking Send.
4. You can hide a conversation by clicking the check box next to it in the left column 

and clicking Hide. Click the Hidden tab at the top of the column to view these 
hidden messages.

Using To-Do’s

Another quick, easy method of communication that Online Design 2016 users have at their 
disposal is the ability to leave To-Do notes for other yearbook staffers. To-Do’s come in 
handy whenever you need to leave a reminder about an assignment or deadline, or edits 
on a spread. Administrators and Editors can leave To-Do’s for anyone while Staff-level 
members can make assignments to themselves.

Where are my To-Do’s?
A user’s To-Do area is visible on the Online Design 2016 home page as well as along the 
footer navigation. 

To open a new To-Do:
1. Click the +New button in the To-Do’s section on the Online Design 2016 home page.

SECTION �1
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2. All users will be displayed under the To: menu. Scroll through and click to select who 
will be receiving this To-Do. More than one user can be selected.

3. Type a message into the text fi eld.

4. If needed, a deadline can be added by clicking the Add due date checkbox and 
entering a date in the Assign date fi eld.

5. Click Create.

Once created, To-Do’s will appear on a user’s Online Design 2016 home page under one of 
two categories, Open or Completed. However, the status of a To-Do can be updated in just 
a couple of steps.

To mark as Completed:
Click the checkbox next to the completed To-Do. The To-Do will automatically be moved to 
the Completed column.

SECTION �1
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You can view your list of completed To-Do’s by clicking on the Completed heading.

To delete a To-Do:
The Completed list can be emptied at any time by clicking the checkboxes for the To-Do’s 
you would like to permanently delete and then clicking Clear All.

SECTION �1
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GETTING ORGANIZED WITH PLAN BOOK
A ladder is an at-a-glance look at how the pages of your yearbook are organized. If you 
have worked on the yearbook before, you are probably familiar with a ladder poster or 
diagram hanging on the wall. 

Within Online Design 2016, your complete ladder exists within a section called Plan Book. It 
serves the same basic purpose as that ladder poster, but it can also do much, much more.

You were fi rst given a snapshot of your ladder on the home page, but Plan Book shows the 
entire ladder and allows you to do the following organizational tasks:

• Set up your preferences for fonts and color styles
• Enter in titles, due dates and color information for spreads 
• Assign spreads to staff members

Choosing fonts

A wide selection of Walsworth’s fonts are available to use with the creation of your year-
book in Online Design 2016, and you can select up to 30 of those fonts within Plan Book.

To choose fonts:
1. Click Fonts in the Plan Book task menu.

SECTION �2
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2. Scroll through the list of available fonts in the menu on the left. Click to select a font 
you would like to use and it will appear in the main list of selected fonts in the middle 
of the page. 

3. You can remove a font by clicking the red x that appears in the top right corner of 
the font’s preview box. Please note that Helvetica and Times, the two default fonts, 
can’t be removed.

Setting up color styles

Creating custom color styles using combinations of Walsworth’s Formula Colors can 
be helpful when you start designing pages. Assigning color styles will help with book or 
section continuity.

To create custom color styles:
1. Click Color Styles in the Plan Book task menu. 

2. Click the New button.
3. In the new window that displays, scroll through the color selector on the left to view 

the different Walsworth Formula Color options. Click to select the colors that you 
want in the custom style and they will appear in the window on the right.

4. In the text fi eld on the right, enter a name for the custom color style for example, 
“Sports section.” When you are fi nished, click Create.

SECTION �2
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Enter spread details

Planning coverage will be one of the fi rst, and most important, tasks your staff will need 
to get done. You can enter your spread details, including topics, due dates and color 
information through your Ladder in Plan Book. 

When you click to enter the Plan Book area, you will always arrive on the Ladder in the task 
menu.

To enter spread titles:
For a single spread – 

1. Click on a spread within the Ladder preview. The spread details screen will open in a 
new window.

2. Enter a title for the spread in the Assign Page Title text fi elds. For example, “Open-
ing Spreads,” “Academics Divider” or “Homecoming Football Game.” Information 
will automatically save as you enter it.

3. When you are fi nished, close the window by clicking the x in the top right corner.

For multiple spreads – 
1. Under Assign in the right sidebar, click Titles.

SECTION �2
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2. Enter page numbers in the Start and End fi elds to select a page range for the pages 
you would like to label. Or click the radio buttons to choose all left pages or all right 
pages. 

3. Enter a title for the spreads in the Assign Page Title text fi eld. Then click Apply.
4. You can also choose to click pages in the Ladder preview on the left side of the 

screen and enter titles in the text fi eld. 
5. When you are fi nished, click Done.

To enter deadline dates:
For a single spread – 

1. Click on a spread within the Ladder. The spread details screen will open in a new 
window.

2. Use the calendar to enter a date in the due date fi eld.
 3. When you are fi nished, close the window by clicking the x in the top right corner.

For multiple spreads – 
1. Under Assign in the right sidebar, click Due Dates.

2. Enter page numbers in the Start and End fi elds to select a page range for the pages 
you would like to select, or click spreads in the Ladder preview screen to highlight 
them.

3. Use the calendar pull-down to choose a deadline date. Then click Apply.
4. When you are fi nished, click Done.

To enter color information:
For a single spread – 

1. Click on a spread within the Ladder. The spread details screen will open in a new 
window.

SECTION �2

15_MAN Online Design2rev.indd   16 3/25/15   10:11 AM



17walsworthyearbooks.com

2. Use the drop-down menus to choose the color information for your pages, either 
Four Color, Black and White, or a custom color style that has been created.

3. When you are fi nished, close the window by clicking the x in the top right corner.

For multiple spreads – 
1. Under Assign in the right sidebar, click Color styles.
2. Enter page numbers in the Start and End fi elds to select a page range for the pages 

you would like to select, or click spreads in the Ladder preview screen to highlight 
them.

3. Click the color style you would like to apply, Four Color, Black and White, or a 
custom color style that has been created. Then click Apply.

4. When you are fi nished, click Done.

Assign staff to spreads

To help with workfl ow, staff members can be assigned to work on specifi c spreads in 
Online Design 2016 in just a couple of clicks.

To assign staff members to spreads:
1. Under Assign in the right sidebar, click Staff.
2. Choose the spreads to assign, either by clicking to highlight them in the ladder 

preview window or entering a page range.
3. In the Select staff menu on the right, scroll through and click to highlight the staff 

members you want to assign to the chosen spreads. Note that more than one staff 
member can be selected at a time. When you are fi nished, click Apply.

4. After your assignments have been made, click Done.

The Plan Book area is also the home of several other important Online Design 2016 
features, including working with master pages and templates, and submitting your 
spreads once they are fi nished. Those topics will be covered later in this manual and at 
yearbookhelp.com.

SECTION �2
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WORKING WITH PHOTOS
One of the fi rst steps in your creative yearbook process will be to get photographers on 
assignments to document the year.

Once those images are taken, they need to get uploaded and processed. Within Online 
Design 2016, you will be getting your images organized in the Photos area, which can be 
found in the main navigation bar.

In this section, you will learn how to:

• Create photo albums
• Upload photos
• Tag images
• Recommend images to a spread or a staff member
• Edit images
• Work with Walsworth ClikArt and Backgrounds

Create photo albums

Online Design 2016’s Photos area offers you the ability to create photo albums, which 
provides the structure to keep your yearbook images organized as the year progresses. 

You have the ability to name your photo albums whatever you want, in a way that makes 
sense for the workfl ow of your yearbook staff – by date, by event, by section. It’s up to you.

To create a photo album:
1. Once logged in to Online Design 2016, click Photos in the main navigation.
2. Click +New Album.
3. Enter a name for the photo album in the text fi eld. Click Save.

Uploading images

Online Design 2016’s image uploading window can always be accessed by clicking the 
Upload Photos link in the footer navigation, which is persistent on every screen.

The only fi le types that can be uploaded to Online Design 2016 are those with a .tif, .tiff, 
.jpg, .jpeg or .png extension. Only grayscale or RGB color images can be uploaded.

SECTION �3
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Walsworth does not have a size limit on photos that can be uploaded; however, your 
school’s network might. Very large image fi les could take much longer to upload, or even 
time out on your school’s network. 

To upload images:
1. Click Upload Photos in the footer navigation.
2. In the window that opens, click the Choose Photos button.

3. Navigate to the location on your computer that has the image or folder of images 
that you would like to upload and click to select them. 

4. Use the Choose album drop-down menu to pick a Photo Album for the images. You 
can also create a new album for these images by clicking New album, naming and 
saving it. The new album will automatically be selected.

5. If you choose, you can type in a topic for the photo in the Add a topic text fi eld. 
Click Photo topics to see the current list of topics. Adding a topic to a photo will 
allow you to search for a photo by topic later.

SECTION �3
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6. Click Upload. 
7. Progress of the upload will display on the right side and will notify you when it is 

completed. Then you can choose to start another upload or close the window by 
clicking the x in the top right corner. Please note that you can’t close out of the 
upload window until all of your images are uploaded, or the upload process will stop.

Note that Online Design 2016 allows you to have multiple batch uploads going at one time.

Tagging images

The image management tools in Online Design 2016 are geared toward helping improve 
your coverage and creating an index. You can tag images to identify the students who 
appear in the photos. To avoid needing to merge student records later, it is recommended 
that you not tag until after the Portrait CD/DVD has been processed and uploaded to your 
account.

To tag an image:
1. Click Photos in the main navigation.
2. If photos have been uploaded, you will see them organized by photo album under 

My Photos or Photo Albums areas. Scroll through the images and click to select 
an image you want to tag.

3. The photo you selected will open in a new window, showing the image details 
screen in Slideshow view. Click on the Add a student text fi eld in the lower right 
corner.

4. Type the name of the student that appears in the photo. As you type, matching 
names from your student list will populate and appear in a drop-down menu. When 
the correct name appears, click to select it. The name will appear in the window 
above, and the image is now tagged.

SECTION �3
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Recommending images

Once images are uploaded and sorted into photo albums, you can recommend them to be 
used on specifi c spreads or by specifi c staff members.

Although all uploaded images are available for use when editing pages, the extra step of 
recommending can be useful since it places images with the spreads they’re best suited 
for, and with the users who need them.

To recommend an image for a spread:
1. Click Photos in the main navigation.
2. If photos have been uploaded, you will see them organized by photo album under 

My Albums. Scroll through the images and click to select an image you want to 
recommend.

3. The photo you selected will open in a new window, showing the image details 
screen in Slideshow view. Click Recommend in the menu below the photo.

4. In the drop-down menu, choose Recommend for spread.
5. In the new window, click in the ladder preview to select the spread(s) you would like 

to recommend this image for. You can choose a single spread or multiple spreads. 
When you are fi nished, click Recommend. 

To recommend an image for a staff member:
1. Click Photos in the main navigation.
2. If photos have been uploaded, you will see them organized by photo album under 

My Albums. Scroll through the images and click to select an image you want to 
recommend.

3. The photo you selected will open in a new window, showing the image details 
screen in Slideshow view. Click Recommend in the menu below the photo.

4. In the drop-down menu, choose Recommend to someone.

5. In the new window, use the drop-down menu to select the staff member you would 
like to recommend the image for. When you are fi nished, click Recommend. 

SECTION �3
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Editing images

The Photo Editor in Online Design 2016 is powered by Aviary, one of the most 
comprehensive online photo-editing tools available. 

The Photo Editor allows you a wide range of capabilities, from simple adjustments all the 
way to fun special effects.

To edit an image:
1. Click Photos in the main navigation.
2. If photos have been uploaded, you will see them organized by photo album under 

My Albums. Scroll through the thumbnail images and click to select the image you 
want to edit.

3. On the image details screen, click Launch Editor in the menu below the photo.
4. The Photo Editor will open in a new window, showing the tool bar along the top. The 

following tools are available:
• Enhance – Choose one of three enhancement features: Hi-Def, Illuminate or 

Color Fix
• Effects – Pick from this collection of creative fi lters

• Frames and Stickers – Your staff will have fun with these graphic touches

SECTION �3
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• Crop – Reframe your photo
• Resize – Adjust the width and height
• Orientation – Rotate or mirror your image
• Focus – Blur out part of your image
• Brightness, Contrast, Saturation, Warmth and Sharpness – These simple 

tools adjust the color and tone of your image

• Splash – Selectively add spots of color
• Draw and Text – Add your own words and doodles to an image
• Redeye, Whiten and Blemish – Make cosmetic touch-ups to your photos

5. Once you are done making adjustments, click Save. An updated version of the 
image with a “-edited” extension on the end of the name will now appear in the 
same album as the original image.

Note that after you are done editing an image, the –edited version saved into your album 
will be treated as a new image. If you have done any tagging or recommendations on the 
original image, you will need to re-tag or make the recommendations to the newly edited 
version. 

To see and access all photos that have been uploaded in all albums, click Photos in the 
main navigation, then Photo Albums.

To search for specifi c photos or photo attributes, click Photos in the main navigation, then 
Search Albums.

As the book design progresses with tagged photos placed on pages, keep track of student 
coverage by going to Coverage under Photos in the main navigation.

SECTION �3
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ClikArt and Backgrounds

Two other groups of images that will already be present in Online Design 2016 the fi rst time 
you log in are ClikArt and Backgrounds. You can fi nd them in the Artwork section, which is 
located in the main navigation menu.

ClikArt is a collection of pre-designed line art, grayscale and color artwork graphics that 
you can use on your pages. The Backgrounds are Walsworth’s professionally designed 
background images that are already properly sized to fi t on the page. 

You can scroll through the ClikArt and Backgrounds in the Artwork section and download 
the images for your pages.

SECTION �3

15_MAN Online Design2rev.indd   24 3/25/15   10:11 AM



25walsworthyearbooks.com

GETTING TO KNOW PAGE EDITOR
Once you are ready to begin building your yearbook spreads, it’s time to learn all about the 
engine that makes Online Design 2016 run – Page Editor. 

This section will cover all the Page Editor basics, including:

• How to launch a Page Editor session
• All the primary menus, tools and palettes within Page Editor
• Adding text to a page
• Adding images to a page

Launching a Page Editor session

Online Design 2016 provides multiple ways to open one of your spreads in a Page Editor 
session.

• On the home page, click the rectangles on the left side of the Ladder to open 
the status window for a spread. Then click the Edit Spread button. Once you 
have begun work on a spread, a preview of those pages will appear in those 
rectangles. This works the same with the Ladder in the Plan Book section.

• The footer navigation includes a Recently Edited link, which pulls up thumbnails 
of the spreads you have most recently worked on. It also includes a menu that 
allows you to sort by deadline date and a link to open a window with thumbnails 
of all your spreads. Clicking a thumbnail will open a spread’s status window. 
Then click the Edit Spread button.
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• On the home page, click the View All Spreads button located at the bottom of 
the Ladder. Thumbnails of all your spreads will open in a new window and they 
can be opened by clicking Edit Spread. 

Page Editor tools and menus

As you begin working on pages, you need to become familiar with Page Editor’s tools, 
menus and workspace. 

Tools:
Online Design 2016’s main tools appear on the left side of the screen. Here is a description 
of each one and how it can be used in yearbook production.

• Undo/Redo – Remove, or repeat, the most recent action 
you’ve taken on the page

• Selection tool – Select an item on the page and move it 
around, or resize it

• Text tool – Create text boxes by clicking and dragging across 
the page; this tool must also be selected to type or paste text

• Draw tool – Draw free-form objects on the page, either 
angled or curved

• Shapes tool – Opens a fl y-out menu with squares, circles, 
polygons and starbursts; allows you to drag and drop the 
shapes on to the page

• Pan tool – Allows you to pan around the page simply by 
clicking, holding and dragging

• Zoom tool – Zoom in closer to an area of the page
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Menus:
Many of Page Editor’s basic commands can be found in menus along the top of the screen.

 
File >
The File menu contains the common commands to Save and Close your spread. Save as 
Custom Template allows you to take an attractive spread that you would like to re-use, 
such as a divider page, and make it a template. View PDF gives you the option to produce 
a low-res PDF version of your spread for quick proofreading, or a hi-res PDF for fi nal 
proofi ng.

Edit >
The commands under the Edit menu come in handy once you start working with type or 
start moving objects around on the page. Undo/Redo can be found here. Cut, Copy, 
Paste and Delete work just as they do in most word processing programs. However, in 
Page Editor, these functions only work with objects, not text. Check spelling will scan the 
spread for spelling errors. 

Object >
Options under the Object menu allow you to Group and Ungroup objects, as well as Lock 
and Unlock objects. Convert Text to Shape is a popular design effect that allows you to 
turn your text into an object. 

View >
The View menu will adjust the visual settings as you work around a spread. Fit to page 
always adjusts the view back to 100% if you have zoomed in or out. Show Grid and Show 
Guides display different graphical aids to help you while designing. Show Bleed Bars 
shows the area outside of the page shaded in blue, called the “bleed.” Text should not 
enter the bleed bar area or it may be trimmed off during production, while objects intended 
to bleed off the spread must extend to at least the outer edge of the bleed bar. Set 
Columns allows you to adjust the number of column guides displayed on the page.

Page Editor palettes

The Page Editor has fi ve palettes that appear along the right side of the screen and control 
more advanced settings and adjustments.
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Object palette
Whenever an object, such as a photo or a shape, is selected, this palette will be open. The 
Object palette allows you to adjust the width and height of a shape or add a border. From 
this palette, you can also add text on a path.

Type palette
If you are working with copy within a text box, the Type palette is where you can adjust 
font, type size, leading, kerning or add a drop cap.
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Effects palette
The Effects palette allows you to apply graphic effects like drop shadow, transparency and 
gradients to your page elements.

Adding photos to a page

In Section 3, you learned how to upload images into Online Design 2016. Once you start 
working in Page Editor, adding images to your pages can be done in only a few steps by 
using the Photo Tray, which is located in the footer navigation at the bottom of the screen.

To add a photo to a page:
1. Open a spread in a Page Editor session.
2. Click Photo Tray in the footer navigation.
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3. Thumbnails of your images will display in the Photo Tray. Use the Photo Tray menus 
to sort photos by whether they’ve already been placed on a page and to fi nd images 
recommended for you or the spread. You can also search by topic, tagged student 
name and fi le name.

4. Once you fi nd the image you would like to place, drag and drop it from the tray on to 
the page. If you have already created image windows on your spread, drag an image 
over the window to highlight it, then drop it into that window.

5. Images placed in windows will likely need to be cropped. To crop an image, 
double-click the image and select Crop Photo.

Adding text to a page

Headlines, captions and articles are all fundamental pieces of a yearbook spread. Follow 
these steps to add copy within Page Editor.

To add text to a page:
1. Open a spread in a Page Editor session. 
2. Click the Text tool in the Tool menu on the left side of the screen.
3. Create a text box on the page by clicking and dragging your pointer arrow. Once you 

release, your text box will be created with a blinking cursor inside to indicate where 
text will appear. Note that you can also make a shape a text box by clicking inside 
with the Text tool.
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For fun tips and tricks you can do with your photos and text in Online Design 2016’s Page 
Editor, visit yearbookhelp.com throughout the year. 
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APPLYING TEMPLATES AND MASTER PAGES
Once you have made all the decisions associated with planning your yearbook, and you 
have reviewed the basics of the Page Editor, it’s time to start building spreads. A good 
place for many yearbook staffs to start is with templates.

A template is a standard design created or selected by the staff to appear throughout each 
section of the book. Staffs use templates to build unity and consistency in theme and 
design. In Online Design 2016, templates are managed in the Plan Book area. This section 
of the manual will outline:

• Creating custom templates
• Assigning templates to pages
• Working with master pages

Creating a custom template
If your yearbook staff is fortunate enough to have designers who want the blank slate and 
free rein to create their own templates, Online Design 2016 allows them to convert an 
original spread into a custom template within Page Editor. 

To save a spread as a custom template:
1. Open a spread in a Page Editor session.
2. When your template is complete and ready to be saved, go to File > Save As 

Custom Template. 

3. Name your custom template in the text fi eld, then click Save. Your new custom 
template will now appear in the Apply Templates area within Plan Book.

SECTION �5

15_MAN Online Design2rev.indd   33 3/25/15   10:12 AM



34

Assigning templates

The process of assigning templates to your yearbook pages is done in Plan Book. Within 
Plan Book, you will be able to see thumbnails of all the pre-designed templates Walsworth 
makes available, as well as any custom templates you created in Page Editor.

To assign a template:
For a single spread – 

1. Go to the Plan Book section.
2. From the Ladder view, click Apply Templates in the right sidebar. Note that 

templates can also be applied to spreads in the Plan Book > Custom Templates 
task area.

3. In the new window that opens, click to select a spread within the Ladder preview. 
4. Use the drop-down menus to search for the template you want to assign. You can 

scroll through thumbnails for Walsworth’s pre-designed templates, or any custom 
templates you have created. In the text fi eld, you can also search for templates by 
name. Click to highlight the template you choose.

5. Click Apply.

For multiple spreads – 
1. Go to the Plan Book section.
2. From the Ladder view, click Apply Templates in the right sidebar. 
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3. In the new window that opens, enter page numbers in the Start and End fi elds to 
select a page range for the pages you would like to select, or click spreads in the 
Ladder preview screen to highlight them.

4. Use the drop-down menus to search for the template you want to assign. You can 
scroll through thumbnails for Walsworth’s pre-designed templates, or any custom 
templates you have created. In the text fi eld, you can also search for templates by 
name. Click to highlight the template you choose.

5. Click Apply.

Creating and editing master pages

Much like templates, a master page is a document intended to serve as a building block 
for your yearbook. It can be used to set up elements you want to remain consistent 
throughout, like folios, thematic design elements and backgrounds.

Using master pages allows for design consistency and time savings. You set up repeating 
elements once, rather than on every fi le. 

All Online Design 2016 users should note that two master pages, called Master A and 
Master B, already exist the fi rst time you log in. Master A contains only page numbers and 
will automatically be assigned to every page in your yearbook, for those users who never 
get around to using master pages. Master B is a quick and easy master page that can be 
assigned, which contains only page numbers and topics pulled directly from your titles on 
the page ladder. 

To create a new master page:
1. Go to the Plan Book section.

2. Click Master Pages in the Plan Book task menu. 
3. Click the New button.
4. In the text fi eld at the top of the screen, enter a name for your master page. Then 

click Save. The new master page will now appear in the list.
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To edit a master page:
1. Go to the Plan Book section.
2. Click Master Pages in the Plan Book task menu.
3. Find the master page you want to edit in the list. Then click Edit.
4. The document will open in a master page session in Page Editor. Once you 

complete your work, go to File > Save & Close.

It’s important to note that while working on a master page session in Page Editor, the main 
layer and the folio layer are indicated in the top right corner of the screen. Any time you 
insert folio layer items, which includes page number and page topic information and folio 
artwork, they are always arranged on top of all other items on the master page. This way, 
the folio can never be inadvertently covered by another item on the page.

Assigning master pages

Once you have created master pages, applying them to your spreads only takes a few easy 
steps. 
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To assign a master page:
For a single spread – 

1. Go to the Plan Book section.
2. Click Master Pages in the Plan Book task menu.
3. Click Assign master pages in the right sidebar.
4. In the new window that opens, click to select a spread in the Ladder preview. 
5. Under Select Master Page on the right, click to highlight the master page you want 

to assign.
6. Click Apply.

For multiple spreads – 
1. Go to the Plan Book section.
2. Click Master Pages in the Plan Book task menu.
3. Click Assign master pages in the right sidebar.
4. In the new window that opens, enter page numbers in the Start and End fi elds to 

select a page range for the pages you would like to select, or click spreads in the 
Ladder preview to highlight them.

5. Under Select Master Page on the right, click to highlight the master page you want 
to assign.

6. Click Apply.
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PORTRAITS 
The portraits section will always be among the most-read pages in your yearbook. Creating 
the portrait pages will be an important part of your process.

Before you can edit or place portrait images onto your pages, you will need to work with 
your school photographer to have your portraits taken and a portrait CD/DVD created, 
according to the proper specifi cations.

Your portrait CD/DVD will then need to be submitted to Walsworth. The instructions to do 
so can be found in your Portrait CD pack inside your Planning Kit. Once your portraits have 
been processed and uploaded into Online Design 2016, you will be able to work with them 
in the Portraits and Index area of the site. After student record edits are complete, you can 
begin the process of tagging candid photos.

In this section, we’ll outline how you can:

• Edit student information
• Customize the style and adjust the settings of your portraits
• Flow your portraits on to a spread(s)

Editing student information

After your portraits have been processed and made available online, you will be notifi ed by 
Walsworth that they are ready for your use. Then, when you click to enter the Portraits and 
Index section from the main navigation, you will see a list of your students with a thumbnail 
portrait image, fi rst and last name, and grade. Any of this information can be edited for 
an individual student or a group of students. Entries can also be merged in the event of 
duplicates.

To edit student information:
For a single student – 

1. Go to the Portraits and Index section.
2. From either the Students or Portraits menu, scroll through the student list to fi nd the 

entry you would like to edit. Click the thumbnail image.
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3. The student’s entry will open in a new details window. Click Edit.

4. Make changes using the text fi elds and drop-down menus. Note that you can enter 
a new Homeroom for a student by typing it in, and that Homeroom will then appear 
in the drop-down menu. 

5. When you are fi nished, click Save. 
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For a group of students – 

1. Go to the Portraits and Index section.
2. From the Students menu, click the link in the right sidebar that you plan on updating 

for multiple students: Grades, Homerooms or Custom. 
3. Scroll through the student list and click to select the students whose information you 

are updating. 

4. In the text fi eld on the right, enter the new information you are updating for the 
selected students. Then click Apply.

To delete a student:
1. Go to the Portraits and Index section.
2. From either the Students or Portraits menu, scroll through the student list to fi nd the 

entry you would like to delete. Click the thumbnail image.
3. The student’s entry will open in a new details window. Click Delete Student.

4. You will be asked to confi rm that you want to permanently delete the student’s 
portrait and information. If you do, click Delete. Note that deleted student records 
can be restored by typing the deleted student’s name in the Search Students text 
fi eld in the Students task area.

Students who had portraits retaken can appear twice in your portrait list. In this case, you 
will want to select the correct photo and merge the student information.
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To merge two students:

1. Go to the Portraits and Index section.
2. From the Students menu, scroll through the student list to fi nd the two entries you 

would like to merge. Click to select them.

 
3. Click Merge in the right sidebar.
4. In the details window, click on the correct portrait image. Then click Make Primary. 
5. Make any additional edits needed using the text fi elds and drop-down menus. When 

you are fi nished, click Merge. The two previous student entries will now be com-
bined into one.

The Portrait Flowing process

Once you are fi nished editing your portrait information and you are ready to place your 
portrait images on the page, the portrait fl owing process in Online Design 2016 provides 
you with a variety of customization options and settings.

To fl ow your portraits on to a page:
1. Go to the Portraits and Index section.
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2. Click Flow Portraits in the task menu.
3. You will be given two options. If this is the fi rst time you have placed portraits, the 

Start from scratch radio button will be selected. Otherwise, you have the option 
to select the Base on radio button and pre-select the same settings as one of your 
previous portrait fl ows from the drop-down menu. Then click Create.

4. Use the radio buttons on the left to select whether you are fl owing one or more 
groups, and which group you want to fl ow (by grade, homeroom, etc.).

5. Use the drop-down menus on the left to choose the number of rows and columns 
you want to appear on your portrait pages. Based on the selections you make, 
Online Design 2016 will calculate how many pages will be needed for your portrait 
fl ow. That number will appear in the lower right corner.
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6. Once you know how many pages are needed, click to select your portrait spreads 
in the ladder preview on the right. When you have selected enough pages, the blue 
Next button will become active. Click Next.

7. You will now be able to make adjustments to the layout and text. Under Layout, click 
the radio buttons to select portrait names to appear on the side or below images.

8. Under Portraits, click to select the shape of your portrait images. Click the check-
box if you want to put a border around the images.

  9. Under Names, use the drop-down menus to apply text changes.
10. Under Spacing, adjust the amount of white space between images.
11.  At the top of the window, you can scroll through the different design options for   

  applying knock-outs (or pockets of white space) to your pages. Click to select one. 
      Remove it by clicking Clear knock-outs. You can also apply knock-outs to your 

  pages by clicking the individual image windows in the preview screen.
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Note that each setting you choose will automatically update the preview screen, as well as 
the “Students to fl ow” and “Portrait spaces” numbers in the upper left corner. If any setting 
causes the Portrait spaces to go lower than the Students to fl ow number, you will be given 
a warning and asked to update your settings or add an additional portrait page.

If you prefer to build your pages using manual settings, click the Switch to manual 
spacing link near the bottom of the window. This will allow you to set the portrait width and 
height, text box width, as well as page margins and spacing to your specifi c settings. All 
numbers entered are in points. A red box around a fi eld means you have entered a number 
too big for your current page size.

12. To view what your portrait page layout will look like at any time, click the Preview  
  button in the lower right corner. 

13. When your pages are set the way you like, click Flow portraits.
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INDEXING
Right after picking up the yearbook on distribution day, most readers will turn to the index 
and look for their name to fi nd their photos. Next, they’ll search for all their friends. 

That’s why your yearbook’s index will be some of the book’s most important pages. 
Fortunately, indexing within Online Design 2016 should be a stress-free process, thanks to 
the site’s auto-indexing capabilities that are constantly working behind the scenes as you 
work on pages. This section will cover:

• How to add names of organizations to your index list
• Matching names to your index while working on pages
• Flowing your index on to the page

As you work on the index, you will always be able to see the current status of it in the 
Portraits and Index area. For both students and organizations, as names get matched to 
pages, the page numbers will appear on the same line as the name under the Indexed on 
column.

Adding organizations to the index

As outlined in Section 6, your student list will appear in the Portraits and Index area once 
you have submitted your portrait CD/DVD to Walsworth and it has been processed. 
However, for organizations that you want to appear in the index, you must add the names 
manually. 

To add an organization name to the index:
1. Go to the Portraits and Index area.
2. Click Organizations in the task menu.
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3. Click +New Organization in the right sidebar.

4. Type the name of the organization in the text fi eld. Click Save. The name will now 
appear in your list of organizations and can be matched for your index. 

To delete an organization name from the index:
1. Go to the Portraits and Index area.
2. Click Organizations in the task menu.
3. Click to highlight the organization(s) you want to delete.
4. Click Delete in the right sidebar.
5. A message will display asking you to confi rm that you want to delete the 

organization(s). If you do, click Delete again.
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Indexing from spreads

The best part about the indexing process within Online Design 2016 is that it is working 
all the time. While you are working on spreads in the Page Editor, adding text and tagging 
images, your pages are being scanned for index matches. 

Then when you are fi nished working, you will have the opportunity to review all the potential 
matches on your spreads and decide if you want to add them to the index. Once you have 
begun working on pages, use these steps below to review and edit your index as your work 
progresses. 

To review/edit your index information:
1. When you are fi nished working on a spread in the Page Editor, go to File > Save &  

Close.
2. The spread details window will appear. Click View Index in the upper right corner.
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3. In the new Indexing window that opens, you will see the list of proper names that 

have been identifi ed as potential index matches on the spread. Student or   
organization names that have been matched to your lists will display on the right   
under the Matched column, along with the page they were found on and where they  
were found (text or photo). 

4. Names that appear under the Matched column will appear in the index. To remove  
them, click the x at the end of the row and the name will be moved to Ignored.

5. Any two words in a row on a spread in upper case will be fl agged as a possible   
match during a scan. These proper names that were scanned but didn’t match   
your student or organizations list will appear on the left side of the window under the  
Unmatched column. To review one of these names, click on an entry. 
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6. A new window will open allowing you to add or delete the name. To add this name  

into the index, click either +Add as new student or +Add as new organization. 
You can delete the name by clicking Ignore. 

Note that any name you have deleted and moved over to the Ignored column can be 
brought back. Simply click the Ignored heading, fi nd the listing you want to retrieve and 
click the Refresh icon located to the right of the line. That name will be moved back to the 
Unmatched list, and you will be able to review it again.
  
The Index fl owing process

Your index should be part of the last shipment of pages that you submit with your 
yearbook. Index as many proofed spreads as you can before you fi nalize the book.

Once you are confi dent that enough of the book is complete and your index information is 
ready to be placed on the page, you will need to return to the Portraits and Index area.

To fl ow your index on to a page:
1. Go to the Portraits and Index section.
2. Click Flow Index in the task menu.
3. Your yearbook’s ladder will be displayed, along with a list of index matches for each 

page. If any line still lists unmatched names, you can do a fi nal check by clicking the 
line and the Indexing window for that spread will open. When you are ready for the 
next step, click Flow Index in the right sidebar.

4. In the new window that opens, fi nd the pages on which your index will appear and 
click to select them. When you have selected enough pages to fi t your index infor-
mation, the blue Next button in the lower right corner will become active. Click Next.
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5. You will now be able to make adjustments to the layout and text. Under Names, use 

the menus to adjust the alignment, spacing and other text changes.

6. Under Headings, you can adjust spacing, alignment, font and type size.

7. The drop-downs at the top of the window allow you to adjust the number of 
columns/page and the column height.

8. At the top of the window, you can scroll through the different design options for 
applying knock-outs (or pockets of white space) to your pages. Click to select one. 
Undo it by clicking Clear knock-outs. You can also apply knock-outs to your pages 
by clicking the individual image windows in the preview screen.

9. To view what your portrait page layout will look like at any time, click the Preview 
button in the lower right corner. 
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10. When your pages are set the way you like, click Flow Index.
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PROOFING AND SUBMITTING YOUR PAGES
Plenty of hard work goes into creating your yearbook. After all the photos are taken, the 
copy is written and the spreads get designed, it will be time to proof your pages and get 
them submitted by deadline.

In this section, you will learn the process within Online Design 2016 for:

• Requesting PDF proofs of your spreads
• Updating the proofi ng status of your spreads
• Submitting your spreads once they have been approved

Creating PDF proofs

Once a spread is ready for proofi ng, there are a couple of ways you can create a PDF proof 
in Online Design 2016 and update the spread’s status to Proof.

To create a PDF proof of a single spread:
1. From the Online Design 2016 home page, click the spread thumbnail on the ladder 

to open a spread’s details window.
2. Click the Proof this spread link.

3. It might take a couple minutes to generate the PDF, but a View Proof link will appear.  
Also note that the status of the spread will be shifted from Started to Proof at the 
top of the window. Click View Proof. 
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4. Your PDF proof will open in a new browser window, and you should be able to print  
the pages for review.

You can create hi-res PDF proofs for multiple spreads at a time using the following steps.

To create PDF proofs of multiple spreads:
1. Go to the Online Design home page.
2. Click the View all spreads link located at the bottom of the ladder.
3. In the new window that opens, click Request Hi-Res PDFs near the top right 

corner.
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4. Scroll through the spread thumbnails and click to select the spreads you want PDF  
proofs for. The spreads you have selected will be highlighted in blue.

5. Click Request PDFs in the lower right corner. A message will open telling you the  
PDF creation is in progress. 

Approving a proof

Once you have requested PDFs of your spreads, the proofi ng process can begin. 

As you review the high-res PDF proofs, remember to zoom in to 200-300% to evaluate 
image resolution. Also pay close attention to the trim marks around the edge of the page. 
Elements that extend into the trim will be cut off.

Your staff may also want to print a copy of all your high-res PDF proofs and store them for 
archive purposes. 

Once you are done proofi ng a spread and all corrections have been made, you can update 
its status to Approved.

To approve a proof:
1. In any of the ladder views, fi nd a spread in the Proof stage and click the thumbnail to 

open the spread’s status window.
2. Click Approve proof. 
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Submitting your pages

Once proofi ng has been completed for a spread and it has been moved to Approved, those 
pages should be ready for submission by users with the proper permissions – typically the 
adviser. 

Spreads will be submitted in the Plan Book area. However, you must thoroughly review 
your proofs before submission, because once spreads have been submitted there will be 
signifi cant extra charges to bring them back for corrections. So, always be sure to allot 
the time necessary to review proofs carefully and completely before authorizing them for 
submission.

To submit a spread:
1. Go to the Plan Book area.
2. Click Submit Spreads in the task menu.

3. Find the spreads in the ladder that you would like to submit and click to select them. 
Note that you will only be able to select spreads that have been proofed and moved 
to the Approved status. 

4. Click the blue Submit Spreads button when it becomes active.
5. In the window that opens, click the checkbox to certify that you have proofed the 

spread being submitted. Then click Submit.
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